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At the NAALJ’s 2011 Annual 

Conference in Santa Fe, New 

Mexico, the New York affiliate 

showed off its new lapel pins and 

issued a challenge to the other 

affiliates to create lapel pins of 

their own. President-Elect 

Melissa Lin Jones has answered 

the call with the new DCAALJ 

logo below, which will be 

incorporated into pins and other 

items. 

 

 
 

The white background and the 

red stars and bars incorporate a 

deconstructed version of our 

local flag.  The gavel is the 

readily recognizable symbol of 

our beloved profession. Lastly, 

the gold text and outlines inspire 

us to be the very best we can be. 

 

The Board looks forward to 

presenting our pin to the 

membership in the very near 

future. In the meantime, ask 

yourself if you are “Setting the 

Gold Standard for Administrative 

Adjudication.” 

 

President’s Message 

 

DCAALJ is off to a good start 

this year.  We have more than 35 

members who have paid their 

dues, in addition to past members 

who say they plan to renew their 

membership.  Moreover, we have 

increased our membership in 

agencies that were not 

represented before.  In addition 

to the Office of Administrative 

Hearings and the Department of 

Employment Services, both of 

which have large contingents, we 

have judges in the D.C. Contract 

Appeals Board, the D.C. Office 

of Human Rights, and two 

federal agencies.  My hope is that 

we will continue to expand our 

membership base and that the 

judges can share observations, 

concerns, and advice about their 

jobs, what works, and what 

doesn’t work.   

 

At its meeting in January the 

DCAALJ Board approved 

President Elect Melissa Jones’s 

proposal to adopt a logo for 

DCAALJ.  The logo will help to 

confirm DCAALJ’s identity and 

provides a brand for our 

organization.  Each DCAALJ 

D.C. Association of 

Administrative Law 

Judiciary 
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member will receive a DCAALJ 

pin containing the logo.  Melissa 

describes the story of the logo in 

her article below. 

 

We have two educational 

programs planned for the winter 

and early Spring.  In May, 

DCAALJ will co-sponsor the 

showing of “The Response,” an 

award-winning courtroom drama 

by D.C. lawyer Sig Libowitz that 

depicts a three-officer 

Guantanamo military tribunal 

that is divided about whether 

there is sufficient evidence to 

continue to hold a detainee as a 

terrorist.  The film will be 

followed by a panel discussion 

on the constitutional and 

equitable considerations involved 

in the panel’s determination.  We 

will announce the date and 

location of the event shortly. 

 

In April, I will give a 

presentation on MS Word 2010 

for judges.  As I note in my 

article below, Steve Balmer is 

struggling mightily to complicate 

even the simplest word 

processing tasks.  MS Word 2010 

is not the least bit intuitive.  But 

understanding some basic 

concepts and techniques can save 

a lot of grief.  I’ll demonstrate 

some of the tactics I use and 

invite those who attend to share 

their own discoveries.  Date, 

time, and location will be 

announced shortly. 

 

One of the benefits of 

membership in DCAALJ is that it 

includes membership in NAALJ, 

the National Association of the 

Administrative Law Judiciary.  

NAALJ has two upcoming 

conferences that may be of 

interest to DCAALJ members.  

The NAALJ mid-year conference 

will be held at the National 

Judicial College in Reno, 

Nevada, from April 1 through 

April 3, 2012.  It will feature 

presentations on a variety of 

topics, including legal writing, 

dealing with self-represented 

litigants, judicial ethics, bias, and 

interpreters.  Registration, $300, 

is cheap and lodging at the Silver 

Legacy Hotel, $49 per night, is 

even cheaper, so long as you stay 

away from the slot machines.  To 

register, or find out more, visit 

the conference web site:  

www.naalj.org/2012-midyear-

conference-home. 

 

NAALJ’s annual conference this 

year will be at the Ritz-Carlton 

Hotel in New Orleans from 

September 9–13 2012.  NAALJ 

will be holding a joint conference 

with the Federal Administrative 

Law Judges Conference 

(FALJC), providing an 

opportunity for us to compare 

notes with our federal colleagues.  

Hurricanes excepted, I plan to 

attend.  I hope to see some of you 

there. 

 

To keep everyone informed of 

our goings on, Vice President 

Claudia Barber is developing a 

web page for DCAALJ that 

members can access through the 

NAALJ website.  We will post 

some of our documents, member 

lists, and news of events for easy 

access.  The web page should be 

up and running shortly. 

For a final note, I’d like to renew 

my plea for DCAALJ members 

to contribute to the organization 

in whatever way you feel 

comfortable.  We can use 

members for our Nominating 

Committee and Programs 

Committee.  We need articles for 

the newsletter.  We welcome 

talks and presentations by 

members on almost any topic.  

And we can use ideas.  Is there 

something you think DCAALJ 

should be doing?  Let us know.  

Go ahead and ask what DCAALJ 

can do for you.  But also ask 

what you can do for DCAALJ. 

 

 

 
 

DCAALJ Co-Sponsors Award-

Winning Film and Panel 

Discussion 

 

On Thursday, May 10, 2012, 

DCAALJ and sections of the DC 

Bar will co-sponsor a showing of 

The Response, an award-winning 

30-minute courtroom drama by 

D.C. attorney Sig Libowitz, of 

Venable LLP.  Based on actual 

transcripts of the Guantanamo 

military tribunals, the film, stars 

http://www.naalj.org/2012-midyear-conference-home
http://www.naalj.org/2012-midyear-conference-home
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Aasif Mandvi (The Daily Show), 

Kate Mulgrew (Star Trek 

Voyager) Peter Riegert (Animal 

House, The Sopranos) and Mr. 

Libowitz himself, in the tribunal 

of a suspected enemy combatant 

by three military officers who, in 

the vein of Twelve Angry Men, 

must decide his fate.  Following 

the presentation of the film, Mr. 

Libowitz will join in a panel 

discussion by three attorneys 

who participated in the 

prosecution and defense of 

Guantanamo detainees.  Thomas 

B. Wilner served as counsel of 

record to Guantanamo defendants 

in Rasul v. Bush (2004) and 

Boumedienne v. Bush (2008), 

seminal Supreme Court cases 

that upheld the right of habeas 

corpus for accused terrorists.  

Morris Davis served as Chief 

Prosecutor for the Military 

Commissions at Guantanamo, 

leading a multi-agency task force 

of more than 100 personnel from 

multiple government agencies, 

before he resigned in protest to 

political interference and the use 

of evidence by torture.  Capt. 

Jason Wright, of the Judge 

Advocate General’s Corps, 

currently represents two 

Guantanamo detainees. 

 

 

 

 

 
 

The program will run from 6:30 

to 8:30 p.m. in the Jurors’ 

Lounge of the Superior Court of 

the District of Columbia, 500 

Indiana Avenue.  We will email 

details on registration to all 

DCALLJ members shortly. 

 

 
 

 

MS Word for Dummies 

Judges 

 
By Judge Nicholas Cobbs 

Microsoft (MS) Word’s pitiless 

conquest of word processing is 

one of the tragedies of the 21st 

Century.  In the days of 

WordPerfect, we knew where we 

were in a document.  We could 

use reveal codes to follow 

changes in the format.  Fonts did 

not mutate mysteriously.  

Headers did not disappear.  Page 

numbers followed in sequence.  

But the world changed when MS 

Word invaded and subjugated.  

Now even a proficient word 

processor is challenged by the 

attempt to create a document in 

any style or format except an 

approved Microsoft template.  

I’m convinced that Microsoft’s 

motto, in contrast to Google is: 

“Always do evil.” 

Microsoft’s latest products, Word 

2007 and its offspring, Word 

2010, reflect this policy.  Typists 

who spent years searching the 

arcane menus of MS Word 2003 

to find the functions they need 

now must probe different menus 

in the even more arcane ribbon of 

MS Word 2010.  Moreover, 

because Microsoft believes that 

most of its users are illiterate, it 

populates the ribbon and the 

quick access toolbar with 

miniscule icons that bear little 

semblance to the functions they 

control. 

Nevertheless, with a little effort, 

it is possible to make MS Word 

compose a document the way 

you, rather than Steve Balmer, 

want it to look.  While I don’t 

have space here for an in-depth 

discussion of the myriad features 

of the program, I’ll highlight a 

few of the concepts and 

techniques that I have found 

helpful for my judicial writing. 

MS Word 2010 replaced the old 

menu bar with a “ribbon,” 
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containing tabs.  (A funny-

looking globe the far left on 

Word 2007 has, fortunately, 

become a “File” tab on Word 

2010.)  Click on a tab and you 

will get a spread of sub-menus 

littered with symbols that only an 

alchemist could love.  The quick 

access toolbar, underneath the 

ribbon, also contains symbols for 

the functions you use most 

frequently.  Don’t panic.  Place 

your cursor over the icons and a 

box will appear to tell you what 

the function is. 

As in MS Word 2003, 

Microsoft’s organization of the 

functions leaves a lot to be 

desired.  Thus, while settings for 

font and spacing are on the Home 

tab, settings for margins are on 

the Page Layout tab.  Settings for 

headers and footers are not in 

either of these tabs, but on the 

Insert tab.  Formatting page 

numbers, headers, and footers, is 

especially tricky.  There is no 

dialog box in which you can 

consecutively select the format 

and position you want, and also 

instruct the software not to print 

the header or footer on the first 

page. Each of these steps has to 

be separately entered, increasing 

the likelihood that something will 

go wrong. 

Once you learn where the MS 

Word functions are, you can start 

taking control over your 

document.  Begin with the font.  

For reasons closely tied to 

Microsoft’s “do evil” motto, the 

default font in MS Word is now 

11 point Calibri, one that 

lawyers, judges, and most other 

typists never use.  You can 

change the font for a particular 

document by changing the 

settings in the Font Group on the 

Home tab, but you can gain more 

control by opening the Font 

Dialog Box, Ctrl-D, or by 

clicking the nearly obscure arrow 

in the lower right hand corner of 

the Font Group.  The Font Dialog 

Box allows you to set the type of 

font, size, and attributes of your 

font, e.g., large and small caps or 

double underline.  It also has a 

box in the lower left hand corner 

that allows you to set your font as 

the default font.  Click this box 

once you’ve selected the setting 

you use most often, such as 

Times New Roman 12 point.  

With a little good luck, you will 

get your default font rather than 

the 11 point Calibri as the 

starting point for your new 

documents. 

Now that you’ve got the font 

under control, you can adjust the 

paragraph settings.  There are a 

number of icons for settings in 

the Paragraph Group on the 

Home Tab.  Ignore these.  

Instead click the almost invisible 

arrow in the lower right hand 

corner of the Paragraph Group to 

bring up the Paragraph Dialog 

Box.  There you can set the line 

spacing, indentation, before and 

after spacing, and tabs.  You can 

select your most frequent 

configuration as the default. 

To set your margins, go to the 

Page Layout tab.  The margins 

icon in the page setup group will 

bring up settings that Steve 

Balmer thinks you may want to 

use.  To make your own choice, 

click the obscure little arrow in 

the lower right hand corner of the 

Page Setup Group to bring up a 

dialog box where you can set 

margins precisely. 

If you want to change alignment 

or line spacing quickly, use 

keystrokes.  Ctrl-L for left 

alignment, Ctrl-E for centered, 

Ctrl-R for right, Ctrl-1 for single 

space, Ctrl-2 for double space.  

Thus, after you center the 

heading of your document (Ctrl-

E), space down to where you 

want to start your text and 

change to left alignment (Ctrl-L) 

or justified alignment (Ctrl-J) and 

double space (Ctrl-2).  

Keystrokes are also a quick way 

to change font attributes.  You 

can switch to bold (Ctrl-B), italic 

(Ctrl-I), or underline (Ctrl-U), 

without fiddling with the mouse.  

The keystrokes toggle, so when 

you have finished, enter the 

keystroke again to return to the 

regular font. 

Headers and footers can be 

exceptionally problematic with 

MS Word.  At times, a group of 

the most experienced MS Word 

users in our office has spent close 

to an hour trying to get a footnote 

to print out properly or page 

numbers to continue from one 

section to the next.  Headers and 

footers, including page numbers, 

are accessed through the Insert 

Tab in a Header and Footer 

Group.  First select “Header,” 

“Footer,” or “Page Number” 

from the Header and Footer 

Group.  Unfortunately, Microsoft 

does not provide a dialog box to 

allow you to enter all the settings 

at once.  Instead, Microsoft gives 

you a limited choice of page 
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options to choose from.  Before 

you refine your specifications, 

you need to select the template 

that best fits your needs (e.g., 

bottom center) and then click the 

“Edit Header” or “Edit Footer” 

option.  That will bring up a new 

ribbon of options, allowing you 

to change the font and spacing 

and to keep the header or footer 

off the first page.  If your 

document has more than one 

section, MS Word sometimes, 

but not always, assumes that you 

will want new page numbers.  

You have go to a Format Page 

Number submenu in the Page 

Number option to tell the 

document to continue numbering 

from the previous section. 

One way to speed up your work 

is to install icons for the 

applications you use most often 

on the Quick Access Toolbar.  

This is the narrow strip above the 

ribbon.  It usually comes with a 

disk icon for saving, an undo 

icon, and a redo icon, but it you 

can customize it to add any of the 

applications or dialog boxes you 

use frequently.  For example, my 

Quick Access Toolbar has icons 

for printing envelopes, accessing 

style menus, showing properties, 

and accessing the Font and 

Paragraph Dialog Boxes, among 

others.  To add applications to 

your Quick Access Toolbar, click 

the little arrow at the right of the 

icons.  A list of a few popular 

commands will appear.  Then 

click “More Commands.”  

Another longer list of popular 

commands will appear.  If you 

still don’t see what you’re 

looking for, click the arrow at the 

right of the box for “Popular 

Commands” and select “All 

Commands.”  Find the command 

you want and then click the 

“Add” box.  An icon for the 

application will be added to your 

Quick Access Toolbar and can 

now be accessed with a click of 

the mouse. 

Microsoft groups the settings for 

document formatting into 

“Styles.”  This can be helpful 

once you learn how to create 

your own styles or to access 

styles that are already in the Style 

Menu.  For example, I have 

created an “Opinion” style for the 

paragraph format I use for 

opinions and an “Indent” style 

for single-spaced block 

quotations.  When I change from 

one style to another, I can go to 

the Style Menu and select the 

new style without having to 

configure the settings in the 

Paragraph Dialog Box.  The 

Quick Styles Gallery on the 

Home Tab will have a list of 

styles that are available to you.  

You can select one by clicking it, 

or by bringing up a list with 

keystrokes, Ctrl-Shift-S. 

Although Microsoft boasts that 

its styles are simple and user-

friendly, in practice, styles can be 

very frustrating.  MS Word does 

not limit its style selections to the 

ones you want or use frequently.  

Instead, it provides a large library 

of styles you may never want to 

use and will create new ones 

every time you set up a new 

configuration.  To find and select 

the style you want, you must 

wade through a swamp of styles 

you never use.  Then, if you are 

not careful, MS Word will 

assume that you want to apply a 

style that you did not select to 

some portion of your document, 

leaving you to reconfigure the 

settings to the style you want.  In 

addition, MS Word may decide 

that the tweaks you selected for a 

particular document are intended 

to modify your base style. These 

problems can be overcome after 

applied study, but quantum 

physics is easy by comparison. 

One way to avoid having to 

select styles is to use the format 

painter to copy a style that is 

already on your document.  The 

format painter is a tiny little 

brush on the Clipboard group of 

the Home Tab.  Click on a place 

in the document that has the style 

you want to copy, such as a 

paragraph style or an indented 

block.  Then click the format 

painter and move the cursor to 

the text that you want to format.  

The cursor will change into a 

format paintbrush that you can 

then use to select the text you 

want formatted into the style you 

selected.  

You can also use MS Word’s 

Show/Hide feature to show some 

of the formatting of your 

document as you compose.  Click 

the paragraph symbol, ¶, in the 

Paragraph Group on the Home 

Tab, or use the keystroke 

command, Ctrl-Shift-8.  MS 

Word will now insert symbols for 

your spaces, paragraphs, and 

page breaks, so you can see why 

there is a gaping hole between 

your words or why the text ended 

only half way down the page. 
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MS Word’s AutoCorrect and 

AutoText features are 

particularly helpful for judges, 

who repeat the same names and 

phrases in their opinions.  These 

functions, which used to be easy 

to access in MS Word 2003, are 

now more challenging, but they 

are well worth learning.  

AutoCorrect will substitute a 

shortcut set of letters or symbols 

for words or phrases of up 255 

characters.  For example, if I 

need to refer to the District of 

Columbia Unemployment 

Compensation Act, I type “dcc” 

followed by “uca” to produce the 

text.  You can create AutoCorrect 

shortcuts by clicking through the 

File, Options, Proofing selections 

on the left hand side of the 

ribbon.  But a faster technique is 

to use keystrokes:  Alt-T, A, and 

then select the tab for auto 

correct.  You can enter your 

shortcut keys, remove existing 

shortcuts, or turn off auto correct 

entirely by unchecking the box 

for “replace text as you type.” 

Because of the character 

limitation, AutoCorrect cannot be 

used for extended passages of 

text.  These require AutoText.  

Highlight the text to be saved, 

click the Insert tab and the Quick 

Parts option in the Text Group.  

Then select “Save Selection to 

Quick Parts Gallery” and give 

your text a name.  Typing the 

name, and F3, will produce the 

text.  But it can be tricky.  Brace 

yourself for more than a little 

frustration if you set out to 

master AutoText. 

Finally, many users will find that 

they can speed up their 

composition significantly by 

using keystrokes instead of 

mouse clicks for many of the 

most common commands.  

Common commands such as 

print (Ctrl-P), cut (Ctrl-C), paste 

(Ctrl-V), bold (Ctrl-B), italic 

(Ctrl-I), and, one of my favorites, 

undo (Ctrl-Z), can be executed 

quickly with keystrokes, so you 

don’t have to reach for the mouse 

and then hunt for the icon you 

need.  Below are a few of the 

more useful keyboard shortcuts. 

 Ctrl-G go to (page,  

bookmark, section, footnote, etc.) 

 Ctrl-Z undo 

 Ctrl-Y redo 

 Ctrl-F find 

 Ctrl-H find/replace 

 Ctrl-S save 

(Use Ctrl-S to save a long 

document at intervals to avoid 

inadvertent loss.)  

 Ctrl-W close file/folder 

 Ctrl-X cut 

 Ctrl-V paste 

 Ctrl-C copy 

 Ctrl-E center 

 Ctrl-L left justification 

 Ctrl-J full justification 

 Ctrl-R right justification 

 Ctrl-I italics 

 Clrl-B bold 

 Ctrl-P print 

 Ctrl-U underscore 

 Ctrl-1 single space 

 Ctrl-2 double space 

 

MS Word is not nearly as 

intuitive as Microsoft would have 

us believe.  The changes 

implemented in Word 2007 and 

2010 have, if anything, made the 

system even more difficult to 

master.  But the system’s 

complexity is a product of its 

formidable power and capability.  

If you take the time to learn how 

to use Word’s applications and 

shortcuts, the rewards can be 

substantial. 

 
 

D.C. Administrative Law 

Judge  

Inducted into Stetson Law 

Hall of Fame 
 

After graduating magna cum 

laude from Howard University, 

Judge Amelia G. Govan chose 

the Stetson University College of 

Law in Gulfport (St. Petersburg), 

Florida to further her education 

and to foster her passion for the 

law. When she arrived, she was 

the only African American 

woman on campus, but rather 

than hide her talents, she (along 

with former D.C. Department of 

Employment Services, Labor 

Standards Office of Hearings and 

Adjudication, Administrative 

Hearings Division (“AHD”) 

Chief Administrative Law Judge 

Malcolm J. L. Harper) bravely 

founded Stetson’s Black Law 

Student’s Association.  

 

Upon graduation, Judge Govan 

passed the Florida bar and began 

practicing in that state.  She went 

on to clerk for the Second 
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District Court of Appeals, to 

adjudicate appeals with the 

Public Defender’s Office, and to 

serve as counsel for government 

agencies with the Hillsborough 

County Attorneys’ Office.  

 

 

In 1987, Judge Govan was 

admitted to the District of 

Columbia Bar, returned to D.C., 

and joined the Labor Standards 

Bureau of DOES. Today, Judge 

Govan, a member of the 

DCAALJ, presides over workers’ 

compensation cases as an 

administrative law judge with 

AHD.  She was admitted on 

motion to the Supreme Court of 

the United States in May of this 

year. To relax, Judge Govan 

enjoys spending time with her 

four adult children and four 

grandchildren. 

 

 

 
 
Judge Amelia Govan (third from left) 

inducted into Stetson Law Hall of Fame 

 

 

On October 29
th

 Judge Govan, 

along with six other honorees, 

was inducted into the Stetson 

University College of Law 2011 

Hall of Fame. The DCAALJ is 

proud of her! 

 

 

 

     The Twins Have Arrived! 

 

 

 
 

Congratulations to Judge Paul 

Handy, and his wife, Attorney 

Francisca “Frances” M. Recio. 

They are the proud parents of 

Marisa Juliette Handy-Recio 

and Daniel Paul Handy-Recio, 

born on January 20, 2012 at 

6:58 p.m. 

 

 

 
Judge Handy is the immediate 

past president of DCAALJ.  

 

 

 
The District of Columbia Office 

of Administrative Hearings gave 

Judge Handy a daddy shower on 

February 6, 2012. 

             ~~~~~~~~~~~~~ 

Upcoming Events: 
 

The National Association of 

Administrative Law Judiciary 

(NAALJ) will hold its 2012 

Midyear Conference in Reno, 

Nevada on April 1-3, 2012.   

 
There is still time to register 

for the conference and receive 

a $49 per night rate at The 

Silver Legacy Hotel and 

Casino.  NAALJ along with the 

National Judicial College have 

developed two days of 

informative CLE. Plan to arrive 

on April 1, for an evening 

reception (included in your 

registration). An optional 

excursion to Lake Tahoe will 

also be available the evening of 

April 2. Register online at 

www.naalj.org/2012-midyear-

conference-registration.  
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 NAME: ___________________________________________________________________________ 
 

   Last Name   First Name   Middle Name 

 

 HOME ADDRESS: _______________________________________________________________________________________________ 

 

 CITY,  STATE, ZIP CODE:  _______________________________________________________________________________________ 
 
 

 HOME PHONE:   (        ) _____________________  WORK  PHONE:  (       ) ______________________ 
 

 AGENCY NAME:  _________________________________________________________________________________ 
 

 BUSINESS ADDRESS: _____________________________________________________________________________ 

 PLEASE SEND MAIL TO:  ⁭  HOME     ⁭ WORK   

 EMAIL ADDRESS(ES): _____________________________________________________________________________ 

 ARE YOU AN ATTORNEY?:   ⁭  YES     ⁭ NO 

 

REFERRED BY: ________________________________________________________________________________ 

 

 

ARE YOU INTERESTED IN SERVING ON AN DCAALJ OR NAALJ COMMITTEE SUCH AS MEMBERSHIP, PROGRAM DEVELOPMENT, 

LOGISTICS, CONTINUING EDUCATION, COMMUNICATIONS OR CHARTER REVIEW?   

 

⁭  YES          I AM INTERESTED IN:  ___________________________________________________________________________  

⁭ NO 

 
 

 SIGNATURE:  _____________________________________________________ DATE:  _______________________________ 

 
 

 THANKS FOR YOUR INTEREST! 

 
 Send Payment to:   

District of Columbia Association of Administrative Law Judiciary, Inc. 

c/o Hon. William L. England, Jr., Treasurer 

P.O. BOX 77203  

Washington, DC 20013-7203 

AN AFFILIATE OF THE NATIONAL 
ASSOCIATION OF ADMINISTRATIVE LAW JUDICIARY 

 
 
 

District of Columbia Association of 

Administrative Law Judiciary, Inc.   
 

 
 
 
Dues for DCAALJ /NAALJ membership year 2011 – 2012 are now payable for the period from October 
1, 2011 - September 30, 2012. Please remit your payment as soon as possible. The annual payment of 
$50.00 includes membership dues for both the DCAALJ and NAALJ. ($100.00 for sustaining member.) 

 
2011 - 2012  MEMBERSHIP 

APPLICATION AND DUES INVOICE 
 
 


